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TAI LIEU ON TAP
vroN TrN HQC (120 cau)

CAu l: Trong crlc phAn miim sau, phAn mOm nho lir phAn miim r?ng dgng?
A. Windows XP
B. Microsoft Word
C. Linux
D. Unix

Ciu 2t Tr0n hQ tliiiu hirnh Windows, tI6 chuy6n a6i cfra s6 chucrng trinh cfin lirm
viQc ta:
A. Nh6y chgn bi€u tugng chucrng trinh tuong rrg tr6n thanh c6ng viQc (Taskbar).
B. Nh6n giir phim Alt vd.g6 phim Tab cho d6n khi chon du.gc cria s6 chuong trinh.
C. Nh6y vdo mQt vi tri b6t kj,tr6n cira s6 chucrng trinh mudn kich hoat.
D. C6c y tr0n d€u d[ng.

Ciu 3: TOn thu mgc trong hQ tli6u hirnh Windows cAn thoi tlidu kiQn sau:
A. Khdng qu6255 ky tU; 6Ong dugc trung tOn n6u trong cung mQt .6p tt u mpc (cung
thu muc cha) vd kh6ng chria c6c ky tU ddc biQt (/ \ " * ! <>? .

B. TOi rla 8 kli tg, khdng c6 khoing tring vd c6c ky tU ctic biet (/ \ " *' 1..<>? .

C. TOi da255 ky tU, kh6ng b6t d6u bang chfi s6, kh6ng chria khoing trdng.
D. TOi da256 ky tu.

Ciu 4: Muiin kh&i tlQng lai hQ tlidu hirnh Windows XP ta thgc hiQn nhu sau:
A. Vdo b6ng chgn Start vd Turn off Computer vd hQp tho4i xudt hiQn, chon lQnh
Restart.
B. Vdo bing chgn Start vd Turn off Computer vd hQp tho4i xu6t hiQn, chqn lenh Stand
By.
C. Vdo bang chgn Start vd Turn off Computer vd hQp thoai xu6t hiQn, chgn lQnh Turn
off.
D. Vdo bdng chgn Start va l'urn off Computer va hQp tho4i xu6t hiQn, chgn l6nh
Cancel.

CAu 5: Phfrn miim nio ducri tl6y kh6ng phii lir phAn mdm hQ thiing?
A. Microsoft-DOS.
B. Microsoft Windows
C. Linux
D. Microsoft Excel.

CAu 6: \eucri vh miy tinh giao ti6p vfi nhau th6ng qua:
A.H9 di€u hdnh.
B. Dia cring.
C. ChuQt.
D. Bdn phirn.
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CAu 7: TrGn hQ tlidu hirnh Windows, tI6 m& cfra s6 chuong trinh cAn lhm viQc tr6n
hQ tli6u hirnh Windows ta thgc hiQn nhu sau:
A. K6o thi bii5u tuqng chucrng trinh tr6n mdn hinh ndn Desktop vdo bing chgn Start.
B. Vdo bing chon Start vd Run vd chi duong d6n dtln chuong trinh cAn m& vd chon
Cancel.
C. Nh6y drip chuQt tai bi6u tugng cria chuong trinh tr6n mdn hinh nAn Desktop.
D. C6c y tr6n d6u dtng.

Ciu 8: HQ tli0u hirnh Windows XP ln hQ di6u hirnh c6:
A. Giao diQn tl6 hoa.
B. Mdn hinh dQng.

C. Da nhiQm.
D. C6c y tr6n d€u dtng.

Cflu 9. HQ tli6u hirnh Windows sfr dgng giao diQn nio tI6 nguoi dirng giao ti6p vr6,i

m6y tinh?

A. VIn bin.
B. Hinh 6nh.
C. Bi6u tuqng.
D. D6 ho4.

CAu l0: Thao t6c nio sau clfly dugc ding tI6 chgn nhidu tliii tugng kh6ng li6n ti6p
nhau trong hQ tliGu hirnh Windows?
A. Nhdy chuQt vdo tirng d6i tuqng.
B. Nhrly phii chuQt tqi ttmg ct6i tuqng.
C. NhAn gifi phim Shift vd nh6y chuQt vdo tung ttdi tuqng.
D. NhAn gitr phim Ctrl vd nh6y chuQt vdo tung rtOi tuqng.

CAu 11: Trong m6i trudng Windows c6 cic thinh phAn rrio sau tl6y, chgn phuong
6n tlfng ntrAtt
A. Cta s6, bi€u tugng, My Computer.
B. Cria s6, thanh c6ng cu, Recycle Bin.
C. Cria s6, bi6u tuqng, thanh c6ng cp" bi6u ugng.
D. Hinh 6nh.

Ciu 12: Cho thanh cdng cg bao gdm cric nrit lgnh tluqc liQt kO theo thri tg nhu
hinh b6n, nrlt lQnh.f tlugc ding tI6:
A. Tao mdi thu muc.
B. Tim ki6m tQp, thu muc.
C. Phpc h6i thao thao vria thgc hiQn.
D. Sap xtip tQp, thu muc theo thu tg tlng dAn v0 kich thudc.

Ciu l3:Trong hQ tlidu hirnh Windows, mudn t4o thu mur:, ta mo o ma muSn t4o
thu mgc mri,i bGn trong n6 vi:
A. nh6y File vd New vd Folder, go tcn cho thu muc m6i vd nh6n phfm Enter.
B. nh6n t6 hqp phim ctrl + N, go tcn cho thu myc mdi vd ntr6n pirim Enter.
C. nh6y File vd New vir Short Cut, gO tdn cho thu muc m6i .zd nh6n phim Enter.
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D. nhAn phim F2, gd t6n cho thu mqc mdi tpo vd nh6n phim Enter.

cAu 14:Trong hQ tliiiu hirnh windows, mu6n ooi ton cho thu mgc dang chgn ta:
A. nh6y Edit vd Move to Folder, go t0n mdi cho thu muc vd nh6n phim Enter.
B. nhdn t6 hcr-p phim ctrl + R, go t0n moi cho thu muc vir nh6n phfm Enter.
C. nh6y Edit vd Rename, 96 t6n mdi cho thu mpc vd nh6n phim Enter.
D. nhAn phim F2, gO t6n mdi cho thu muc vd nh6n phim Enter.

cau l5:Trong hQ tliiju hinh windows, mu5n sao ch6p cic tQp dang chgn vio bQ
nhf dQm ta:
A. nh6y Edit vd Copy
B. nhdn tO hqp phim Ctrl + C
C. nh6y phai chuQt tai vi tri bAt ki bOn trong ving chfa c6c tQp dang chon, chon lQnh
copy.
D. Cric y tr€n tt6u ching.

CAu l6:Trong hQ tlidu hirnh Windows, mu6n khdi phqc tliii tuqng di x6a, ta mO
cfra s6 Recycle Bin, chgn tl6i tuqng mu6n khdi phgc vir:
A. nh6y Edit vd Restore.
B. nh6y Edit vd Delete.
C. nh6y File vd Restore.
D. nh6y File vd Delete.

Ciu 17: Trong hQ tli6u hirnh Windows, dG xem danh s6ch cic tni liQu (tQp) vtra
thao t6c gin nh6t, ta:
A. Nh6y Start vd My Documnents.
B. Nh6y Start vir My Recent Documnents.
C. Nh6y F ile vd. Open Near Documents.
D. C6c y tr6n tl€u sai.

Ciu 18: Trong hQ tli6u hinh Windows, mu5n thay rl6i hinh ndn cho min hinh
Desktop, ta nhfy phii chuQt t4i vtng tr6ng tr6n Desktop vh:
A" Chqn Properties vd chon thd lQnh DeskTop vir chon hinh 6nh ldm nCn mdn hinh vd
Apply va Ok.
B. Chgn Properties vd chon th6 lenh Settings vir chon hinh 6nh ldm n6n mdn hinh vd
Apply vd Ok.
C. Chqn Properties vir chon thd lQnh Screen save vd chgn hinh 6nh ldm n6n mdn hinh
vdApply vd Ok.
O. f6t ch cdc y tr6n d6u sai.

CAu 19: Trong hQ tli6u hirnh Windows, mu6n thay tl6i hinh niin cho mirn hinh
Desktop, ta nh:iy Start vi Control Panel sau d6:
A. chgn Display vir DeskTop vd chon hinh anh ldm ndn mdn hinh vd Apply vd Ok.
B. chgn Change desktop background vd chon hinh 6nh ldm ndn mdn hinh vd Apply vd
ok.
C. chgn Choose a screen saver vd DeskTop vd chgn hinh 6nh ldm n€n mdn hinh vd
Apply vd Ok.
D. C5c y tr€n d6u d[ng.
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CAu 20: Trong hQ tli6u hirnh Windows, tI6 t4o tludng tit 6iOu tuqng-shortcut) cho
diii tugng l6n mirn hinh Desktop ta:
A. nh6y phii chuQt tAi d6i tuqng cAn t4o shortcut, chgn Sent to vd chgn Desktop
(create shortcut).
B- nhdn git nrit chuQt ph6i tai ddi tugng cdn tao shortcut, k( o thi ra ngodi mdn hinh
n6n, khi bing chgn t[t xu6t hiQn, chgn Create shortcuts here.
C. nh6y phii chuQt t4i vtng tr6ng UAt t<i tr6n ndn min hinh rlesktop, chon New vd
Shortcut vd Browse vd chi ducrng d6n it6n d6i tuqngcAn t4o shortcut vd Next vd d4t t6n
cho shortcut vd Fisnish.
D. C6c y trdn d6u dring.

Cflu 21: Muiin tl6i tOn_ctro thu mgc/tQp tin trong hQ tli6u hinh Windows, ta chgn
thu mgc/tQp tin cffn a6i tOn vir thr;c hiQn thao t6c nio sau tliy?
A. Nh6y File vd chon Rename vd nh4p t6n rndi vd nh6n philn Enter.
B. NhAn phim F2 virnhflp t€n m6i vd nhAn phim Enter.
C, Nhrly phii chuQt t4i thu mr,rc/tQp tin vd nhdp t6n m6i vd nh6n phim Enter.
D. C6c y trOn d6u dring.

Chu22z Ph6t bi6u niro kh6ng ihftng trong c6c phrlt bi6u sau?
A. Trong hQ tli6u hdnh Windows, thu muc c6 thiS chria cdc thu mpc con khdc.
B. Trong hQ tti6u hdnh Windows, thu muc co th6 chua cdc t(:p vd thu muc con khric.
C. Trong hq tli6u hdnh Windows, tOp co thiS chria tQp.

D. Trong h0 <ti6u hdnh Windows, t€p co th6 chua cilc tQp vd thu muc con khilc.

Ciu 23: Trong hQ tli6u hirnh Windows, tl6 xo6 cric tQp/thrr mgc dang chgn ta thqc
hiQn nhu sau:
A. Vdo bAng chgn Edit vd UnDelete vir Yes.

B. Nhdn t6 hqp phim Ctrl + Delete vd Yes.

C. Nhdn phfm Delete vd Yes.

D. Cric y tr0n d6u dring.

Ciu24z Thao t6c niro sau dffy kh6ng t4o dugc thu mgc rnrfi trong hQ tli6u hirnh
Windows?
A. Nh6y phii chuQt t4i vtrng tr6ng b6n trong 6 dia, thu myc mu6n t4o m6i thu muc b6n
trong n6, vio bing chgn New vd Folder vd nh4p t€n cho thu mqc mdi vd nh6n phim
Enter.
B. M& 6 dia, thu mpc ncvi ta mu6n t4o rnoi thu muc bOn trong n6, vdo bing chgn File
vd New vd Folder vd nhdp tdn cho thu muc mdi vdnh6n phirn Enter.
C. MO 6 dia, thu mpc noi ta.mu6n tao moi thu muc bdn trong no, nh6y chuQt viro nrit
lqnh tr6n thanh cdng cg chuAn, nh4p tdn cho thu mqc mdi vir nh6n phim Enter.
D. M0 6 diu, thu mqc noi ta mu6n t4o mdi thu muc b6n trorg n6, nh6y chuQt viro nrit
lQnh tr€n thanh cdng cq chu6n, nh4p t6n cho thu mgc m6i vir nh6n phim Enter.

Ciu 25: fniiit bi niro sau tlfly cria miy tinh khdng thuQc rnh6m thi6t bi xu6t?
A. Man hinh (Monitor).
B. M6y in (Printer).
C. Loa (Speaker).
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D. M6y qu6t (Scaner).

CAu26: Trong h0 tli6u hirnh Windows, d6 d6n cic tQp/thu mqc sau khi tIfl thqc
hiQn lQnh copy, ta mO 6 dia, thu mgc mu6n chria bin sao vi:
A. Vdo bing chgn Edit vd chon Paste.

B. Nh6n t6 hcr,p phim Ctrl + V.
C. Nh6y phii chudt tai vtrng tr6ng b€n trong 6 dia, thu mgc cha vir chon Paste.
D. C6c y tr6n d€u ding.

Ciu 27t Trong hQ tli6u hinh Windows, thuQc tinh nio duoi il6y dirng tI6 tri6n ttri
thanh c6ng viQc (Taskbar) tr6n cic cfra sd chucrng trinh?
A. Lock the Taskbar.
B. Auto-Hide the Taskbar.
C. Keep the Taskbar on top of other Windows.
D. Show the clock.

CAu 28: Trong hQ tli0u hirnh Windows, tI6 phuc trOi t6t ci cic tliii tuqng trong
Recycle Bin (thtng r6c) ta nhriy phii chuQt t4i Recycle Bin vir chgn lQnh:
A. Delete.
B. Restore.
C. Redo.

D. Undo Delete.

Ciu 29: Khi dang so4n thio trong Microsoft Word, xu6t hign c6c g4ch tI6 ducri
mQt sii tir, d6u hiQu iI6 cho bi6t:
A. C6c tu d6 bi ta gO sai d6u ti6ng viQt.
B. Nhirng tt d6 kh6ng c6 trong tu di6n cria Word.
C. Nhirng ttr d6 nf,m trong dopn v6n b6n c6 d6u c6u kh6ng dfng v! tri.
D. Ph6ng chir ta dang sfr dung soan th6o kh6ng phu hqp vdi b6ng mE dang chon cria
b0 gO ti6ng vi6t md ta dang cdi dflt tr6n miiy tinh.

C6u 30: Muiin ilinh d4ng do4nvin bin trong Microsoft Word, trufc tr6t ta phii:
A. Di chuy6n con tr6 vdo vitri b6t ki tr€n doan v6n b6n mu6n dlnh dang.
B. Qu6t chon doan v6n b6n.
C. Nh6y phdi chuQt t4i vi tri cu6i cung cria doan vdn bin.
D. Qudt chgn dopn v5n biin ho4c di chuy6n con tro soan th6o vho vi tri b6t ki tr6n doan
van bin mu6n dinh d4ng.

Cffu 31:Trong Microsoft Word, OG ttray aiii ptrOng chti, miu chii vh kich thufc
cria mQt cgm ttr nho d6 trong vin bin, trufc ti6n ta phii thgc hiQn thao t6c niro
duni diy?
A. Chgn todn b0 cqm tir d6.
B. Nh6n t6 hqp phim Ctrl + Z.
C. Di chuy€n con tr6 soan th6o vdo bOn trong cgm ttr do.
D. Qudt chgn ki tU cuOi ctng cta cpm tu do.

CAu 32: Trong Microsoft Wordo bing chgn ndro li6n quan tl6n viQc hiQu chinh
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do4n vin bin?
A. Insert.
B. Edit.
C. Format.
D. Table.

Cflu 33: D6 c6n tldu hai bi6n (bi6n trii vir bi6n phii) cho do4n vIn bin, ta dtng t6
hqp phim:
A. Ctrl + E
B. Ctrl + J
C. Ctrl + L
D.Ctrl + T

CAu 34: Trong Microsoft Word, mu5n tlinh d4ng miu chtl cho ki tr; (nh6m ki tU)
dang chgn, ta vio bing chgn Format vir chgn lQnh
A. Paragraph...
B. Font...
C. Bullets and Numbering...
D. Border and Shadding...

CAu 35: Nh6n t6 ngp phim nio sau tlfly tI6 ilinh d4ng cgm tir dang chgn sang ki6u
chfr in tlfm?
A. Ctrl + B
B. Ctrl + I
C. Ctrl + U
D. Ctrl + R

CAu 36: Trong Microsoft Word, mu6n thut lti trii cho do4n vIn bin dang chgn,

Vdo bing chgn Format vd chon lQnh Paragraph...
Vdo bang chgn File vh chgn lQnh Page Setup...
Vdo bing chgn Insert vh chgn Symbol...
Nh6y chgn Print Preview tr6n thanh c6ng cp chuAn

ta:
A.
B.
C.
D.

Ciu 37: Trong Microsoft Wordo mu5n xu6ng ddng nhung chua t<6t ttrrlc do4n vln
bin ta dtrng phim (t6 hqp phim) nio sau tliy?
A. Enter
B. Shift + Enter
C. Alt + Enter
D. Ctrl + Shift +:

Ciu 38: Trong qui trinh so4n thio vln bin voi Microsol't Word, tI6 chin Table
(Bf,ng) ta:
A. Vdo b6ng chgn Thble vd Insert vd Table...
B. Vdo bing chgn Table vd Delete va fable
C. Vdo bing chgn Insert vir chon Object...
D. C6c y tr€n d6u sai.
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A
B
C

D

CAu 39: D6 x6a cQt trong Table, ta vio bing chgn Tabte virDelete vir chgn lQnh:
Cells

CAu 40: Trong Microsoft Word, tI6 sip x6p dii IiQu trong mQt Table ting/giim dffn
theo mQt tiOu chu6n, ta di chuy6n con trd chuQt tl6n vi tri b6t k) trong Table vdr:
A. Vdo bdng chgn Table vd Sort...
B. Vdo b6ng chgn Data vi Sort...
C. Vdo bing chgn Window vd chon Arrange All...
D. Word kh6ng h6 trq tfnh ndng sap xtfp dir liQu trong Table.

Ciu 41: Trong Microsoft Word, d6 chia I 6 tr6n Table thirnh nhidu 6 ta di chuy6n
con tr6 chuQt tl6n 6 cin chia, viro bing chgn Table vdr chgn lQnh:
A. Split Cells...
B. Merge Cells
C. Insert vir chon Rows Above
D. Insert vir chon Columns to the left

Ciu 422 Trong Microsoft Word, tI6 nh$p cic 6 dang chgn tr€n Table thinh I 6 ta:
A. Vao bing chgn Table vd chon Merge cells.
B. Nhay drip chuQt tai kh6i 6 dang duoc chon vd Delete.
C. Nh6n phim Delete.
D. C6c y tr6n dOu tlfng.

CAu 43: Trong Microsoft Word, mu6n tlinh d4ng chii rcri (thqt c6p) tIAu doqn, ta
A. vdo b6ng chgn Insert vd Picture vir chon lQnh Word Art ...
B. viro bdng chgn Format vir chgn lQnh Drop Cap...
C. vdo bing chgn Format vd chon lQnh Tabs...
D. viro bing chgn Format vir chon l6nh Font...

Ciu 44: Khi ta nh:iy iftip chuQt vho bi6u tuqng Microsoft Word (bi6u tugng niry
nIm t4i g6c tr6i cria thanh ti6u dii), ili6u gi sE xiy ra?
A. Tao mQt tQp vdn b6n m6i hay cdn ggi ld mo trang vdn bdn mdi.
B. D6ng t€p vdn b6n hiQn hdnh.
C. Md tQp van bdn dang t6n tai tr€n dia.
D. Luu th6m nQi dung cho tQp v6n btn hiQn hdnh.

Ciu 45: Mutin chia do4n vin bin dang tlugc qu6t chgn ra thirnh nhidu cQt, ta:
A. Vdo b6ng chgn Format vir Columns...
B. Vdo bing chgn Table vir Insert vir Columns.
C. Nh6n chgn bi6u tugng tr6n thanh c6ng cu chuAn.

D. C6c y tr6n d6u d0ng.

Cf,u 46: Trong Microsoft Word, AG tQp tI6 hga vio vin bin ta:
A. Vdo bing chgn Insert vd Picture vd From File...
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B. Vdo bing chgn Insert vd Symbol...
C. Vdo bing chgn Insert vd Page Numbers...
D. Vdo b6ng chgn Insert vd Date and Time...

CAu 472 Trong Microsoft Word, mu6n chin cic ky tU tlic biQt vio vin bin, ta vio
btlng chgn Insert vir chgn Symbol vi:
A. Chqn ky tU cdn chdn vd Apply vd Ok.
B. Chgn ky tU cAn chdn vi Insert vd Close.
C. Chqn ky tU cdn chdn vd Ok.
D. Nh5y phii chuQt t4i ki tU cAn chdn vd Open.

Ciu 48: Trong Microsoft Word, tI6 c6 kf tU 1'. trong vIn bin ta thgc hiQn nhu sau:
A. Vio bing chgn Insert vd Bullets vd chon ki tg;d Insert vd Close.
B. Vdo b6ng chgn Insert vd Picture vd Clip Art vd chqn ki tu vd Insert vd Close.
C. Vdo bing chgn Insert vd Symbol vd nhdy dtp chuQt vdo ki tU cAn chdn vd Close.
D. C6c y tr0n d6u sai.

Ciu 49: fA hqp phim nio sau tIAy dirng tI6 chin dAu nglit trang trong Microsoft
Word?
A. Ctrl + Shift + Enter
B. Ctrl * Enter
C. Alt + Enter
D. Ctrl +:

CAu 50: Ti6u tI6 trang (Header and Footer) lh gi?
A. La nQi dung dugc trinh bdy o giira trang vdi t6c dqng chrnh li m6 t6 nQi dung cria
trang.
B. La sO ctia c6c trang trong tQp v[n bin.
C. La nhirng phAn v5n bin xu6t hiQn tr6n moi trang trong tQp v5n bdn vd g6m phAn dAu
trang (header) vd chdn trang (footer).
D. C6c y tr€n ddu dtng.

Ciu 51: Trong Microsoft Word, tI6 chin ti6u tld trang, ter chgn lQnh Header and
footer trong bing chgn:
A. [nsert
B. Tools
C. Format
D. View

Ciu 52: Mu(in d6nh s5 cho cic trang vin bin tr6n Microsoft Word ta:
A. Vdo bing chgn Insert vd Object...
B. Nh6n t6 hqp phim Ctrl + P
C. Vdo bing chgn Insert vd Page Numbers...
D. Vdo b6ng chgn View vii Page Numbers...

ciu 53: Trong Microsoft word, a6 nm crlc kf trr "( " vi thay th6 beng c6c kf tE
"('n trong toin bQ tQp vin bino ta thqc hiQn:

8



A. Vdo bing chon Edit va Find... (hopc nh6n t6 hqp phfm Ctrl + q;
B. Vdo b6ng chgn Edit vd Replace... (hoqc nhAn t6 hqp phirn Ctrl + H)
C. Vdo bing chgn lnsert vd Symbols....
D. Vao b6ng chon Table vd Convert vd Table to text...

Cflu 54: D6 chin ngit trang trong Microsoft Word, ta vi bing chgn Insert, chgn
lQnh Break, sau d6 chgn mgc:
A. Page break vd Ok.
B. Column break vd Ok.
C. Text wrapping break vd Ok.
D. Next page va Ok.

C0u 55: TrOn hQp tho4i Page Numbers, tI6 chgn vi tri trOn lii, ta khai b6o t4i muc:
A. Position.
B. Show number on first page
C. Alignment.
D. Format...

Ciu 56: Khi vIn bin tlang tlugc in ta th6y bi6u tugng & b6n phii thanh cdng viQc.
N6u muiin ngtrng viQc in, ta thqc hiQn nhu sau:

A. Nh6n t6 hqp phim Shift + Delete.

B. Nh6n phim Delete.

C. Nhriy drip bi6u tugng miiy in, chgn t6n tQp vdn bin dang in, nh6y Document d

Cancel.

D. C6c y tr6n d€u dring.

Ciu 57: Muiin b$t tfnh ning gd tit trong Microsoft Word, ta vio bing chgn
Tools, chgn lQnh AutoCorrect Options sau tI6 d6nh diu chgn mqc:
A. Exceptions...
B. Correct Two Intial CApitals
C. Add
D. Replace text as you type

Cf,u 58: D6 tqo m$t mi b6o vQ tQp vln bin trong Microsoft Word, ta vio bing
chgn Tools, chgn lQnh Options sau iI6 nhip mft mi cho tQp vin bin t4i trang (th6
lQnh):
A. Edit
B. Print
C. View
D. Security

Cfru 59: D6 sao ch6p ilinh deng cria cgm tir dang chgn ta sfr dqng nrit lQnh niro
sau dffy?
A. (Copy)
B. (Paste)

C. (Format Painter)

.\
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D. (Drawing)

Cffu 60: Mutin 6p dgng ki6u (Stylel aG Ointr d?ng trong Microsoft Word, ta thqc
hiQn nhu sau:
A. EAt con tr6 vdo doan vin cAn dinh d4ng, m& hQp ki0u (Style) bing c5ch nhriy chuQt
t4i nft mfli t6n b€n phii hQp sau d6 chgn ki6u thfch hqp.
B. DAt con tr6 vdo doan v[n cAn dinh dang, nh6y chgn ph6rrg cht tai hQp Font vir chon
kich thudc cht tai hQp Size .

C.. Nh6n lugt c6c t6 hqp phim Ctrl + B" Ctrl + I vd Ctrl + U sau khi quet chon doan van
cdn dinh dang..
D.C6c y tr6n d6u dring.

CAu 61: Hirm LEN("Microsoft Excel 5.0") cho ktit qui
A. 19

B. t7
c. l5
D.25

Ciu 62: Hirm RIGHT("Microsoft Excel 2003", 4) cho kit qui
A. "Microsoft Excel 2003"
B. "Microsoft"
C. "'Excel 2003"
D. "2003"

Ciu 63: Hhm TRIM(" Microsoft Excel 2003 ") cho k6t qui:
A. "Micro soft"
B. "Microsoft Excel"
C. "Excel 2003"
D. "Microsoft Excel 2003"

Ciu 64: Him MlD("Microsoft Excel 2003'0,10,5):

A. "Microsoft"
B.'oExcel"
c. "2003"
D. "Excel 2003"

Cffu 65: Trong MS Excel hirm ABS(A7) A5 : -5 dtng tI6:

A. Tinh gi|trituyeJ d6i cria sO A.7 : 5

B. Tfnh t6ng cria sO aZ
C. Tinh c[n b4c hai cta s6 aZ
o. r6t ci d6u sai

r0



Cffu 66: Trong MS Excel hnm SQRT(A9) dtng tI6:

A. Tinh tdng cua s6 Ag
B. Tinh gi6tri. tuyQt d6i cira s5 ag
C. Tinh can b4c hai cria sO ag
D. T6t ci ddu sai

Chu 67: Him SUM(-12, -5,7,100) cho k6t qu6:

A. 100

B.9
c. -90
D.90

Cf,u 68: Hirm MAX(8, 29, -11,33, -51) cho k6t qu6:

A. -51

8.8
c.33
D.29

Ciu 69: Him MIN(-52, 20, -11,23, -15) cho k6t qui:

A.20
8.23
c. -52
D. -15

Ciu 70: Trong bing tinh Excel, t4i 6 A2 c6 sin gi6 tri s6 25; Tqi 6 82 gd vio c6ng
thr?c:SQRT(A2) thi nh$n tlugc k6t qui:

A.0
B.5
C. #VALUE!
D. #NAME!

CAu 7l: Trong b:ing tinh Excel, t4i 6 A2 c6 sin gi6 tri chu6i "Tin hoc"; 6 82 c6 gi6
tri s6 2008. T4i 6 C2 gd viro c6ng thrlc:A2+82 thi nh$n tlugc k6t qu6:

A. #VALUE!
B. Tin hoc
c.2008
D. Tin hoc2008
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Cfru 722 Khi tlang lirm viQc vcri Excel, tii hqp phim nio r:ho ph6p ngay l4p trfrc tlua
con tr6 vd O aau fi6n (6 Al) ciia bring tinh?

A. Shift+Home
B. Alt+Home
C. Ctrl+Home
D. Shift+Ctrl+Home

Ciu 73: Trong bf,ng tinh Excel, n5u trong mQt 6 tinh c6 c6c ki hiQu #####, tlidu tI6
c6 nghia ln gi?

A. Chuong trinh b6ng tinh bi nhi6m virus.
B. C6ng thric nhflp sai vd Excel thdng bao l6i.
C. Hdng chua 6 d6 c6 dQ cao qu6 th6p ndn kh6ng hi6n thi h5t ctrf sO.

D. CQt chria 6 d6 c6 dQ rQng qu6 hgp n0n khong hi6n thi h6 chir s6.

Ciu 74z Trong Excel, t3i 6 A2 c6 gi6 tri ln chu6i TINHOC. T4i 6 B2 96 cdng thric
:RIGHT(A2,3) thi nhfn tlugc k6t qui?

A.3
B. HOC
C. TIN
D. Tinhoc

CAu 75: Trong khi lim viQc vrfi Excel 2007, mu5n luu biing tinh hiQn thtri viro dia,
ta thgc hi$n:

A. Window - Save
B. Edit - Save
C. Office Button - Save
D. File - Save

CAu 76: Ciu niro sau tl6y sai? Khi nhap dfr liQu viro bing tinh Excel thi: Xem th6m:
Diy Nio Duti,i DAy Chi G6m Ctr6t DiQn Li M4nh chi tiSt nh6t:

A. Dfr liQu ki€u s5 se m{c nhi6n can thing td trai
B. Dfi liQu ki6u ki tU sE m{c nhi6n c6n thlng tC trai.
C. Dt liQu ki6u thdi gian se m5c nhi6n cdn thing le phai.
D. Dfr liQu ki6u ngdy th6ng sE m{c nhi6n cin thing iA phai.

cdu77: Trong bing tinh Excel, t4i 6 A2 cb sin gi6 tri sti khdng (0); Tgi 6 82 96 viro
cdng thric :5tA2 thi nhfn duqc k6t qurl:

A.0
B.5
C. #VALUE!
D. #DIV/O!
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Ciu 78: Trong bing tinh Bxcel, tliiju kiQn trong hdrm IF dugc phit bi6u ducri d4ng
mQt ph6p so sinh. Khi cAn so sfnh khic nhau thi sfr dqng ki hiQu nio?

A,#
B.<>
c. ><
D.&

Cffu 79: Trong bf,ng tinh Excel, t4i 6 A2 c6 sin dil liQu ln diy ki
phong"l T4i 6 B2 gd vio cdng thrl'c:LOWER(A2) thi nh$n dugc

A. TIN HOC VAN PHONG
B. Tin hoc van phong
C. tin hoc van phong
D. Tin Hoc Van Phong

tg
t<6t

ttTin hoc van
qu6?

Cflu 80: Trong bing tinh Excel, tai 6 A2 96 vio c6ng thrirc :IF(3>5,100,
IF(5<;6,200,300)) thi k6t qui nh$n duqc t4i 6 ,A2 lir:

A.200
B. 100

c. 300
D. False

Cflu 81: Dqng nio sau il6y dtng tI6 xem mQt slide duy nhit:

A. Normal view
B. outline view.
C. Slide show.
D. slide view.

CAu 82: B4n c6 th6 ddi miu ndn cta c6c slide theo cich tiit nh6t sau <Iffy:

A. Chgn fbrmat/background.
B. Nh6p vir o nft fill color tr€n thanh drawing.
C. Chqn format/slide design.
D. Chgn format/objects.

CAu 83: C6c slide cfia presentation c6 th6 tlugc xem duri,i m6y d4ng khic nhau:

-uYl'--
rRU
:rir
nilr
Qrrt
It Ii
;-*
-

A.3
B.4
c.s
D.6
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Cffu 84: Slide color scheme lir gi?

A. BO mdu chuAn cta power point
B. Mdu n0n
C. Chdn mdu vdo c6c slide
D. TCn cira mQt slide mdi

CAu 85: Trong Microsoft Word aG teng cO chit ta sfr dU ng t6 nqp phim:

A. Ctrl + Shitf + l
B. Ctrl + 

1

C. Ctrl + ;
D. Ctrl + B

CAu 86: Trong cira sd Microsoft Excel dang mo, td hqp phim niro tI6 m& mQt tQp
Excel di c6 trOn m6y tinh?

A. Ctrl + O
B. Ctrl + N
C. Ctrl + w
D. Ctrl + M

Cf,u 87: Trong Powerpoint 2010, viro Home lLine Spacing?

A.E9 quy dinh khoang crich gifra c6c dong
B.Dg quy dlnh khoing c6ch gifta c6c doan
C.Dg quy dinh khoAng c6ch giira c6c dong, doan
D. Tat ci d6u

CAu 88: Trong Microsoft Excel k6t qui cua c6ng thrfrc :COUNT(.,a,',,,b,,,2,,3\ +
COUNTA (" a" r"b" r0, 1) le?

CAu 89: PhAn history trong m?ng internet dtng tI6:

A. Ligt kC c6c trang web dd du ng trong qu6 khri
B. LiCt kC c6c dia chi mail dE dung
C. Li6t k€ t6n ciic trang web
D. Liet kC sO ngud i d[ sri dung mang internet

CAu 90: Web site tn gi?

A. ld mQt ng6n ngir si6u van ban

A.6
8.7
c.8
D.9
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CAu 91: Sau khi d5 chgn mQt do4n vin bin, cdch niro sau tl6y khdng phii tI6 lnm
m6t ai do4n vln bin d6?

A. NhAn tO hqp phim Ctrl + C.
B. NhAp chuQt tr6i vdo nrit lQnh Cut (bi0u tuqng ld c6i k6o) tr6n thanh c6ng cp.
C. Nhdn phim Delete.
D. Chgn Edit -> Cut.

Ciu 922 Trong PowerPoint Dang trinh chi6u mQt biri trinh di6n, mu5n dtrng trinh
di6n ta nh6n phim:

A. Tab
B. Esc
C. Home
D. End

Ciu 93: Mutin kE dudng vidn miru xanh cho mQt Text Box trong gi6o r{n diQn tir,
sau khi chgn Format -> Text Box, chgn th6 Color and Lines vi?
A. Chgn miru xanh trong 6 Color ngay dudi chir Fill.
B. Chgn mdu xanh trong 6 Color ngay dudi cht Line.
C. Chgn miru xanh trong 6 Color ngay dudi chir Line hoflc Fill d€u dring.
D. Chgn mdu xanh trong 6 Color ngay dudi chir Line hoac Fill d6u sai.

CAu 94: D6 thgc hiQn viQc chin bing bi6u vio slide ta phii:

A. Chgn Table -> Insert Table
B. Chgn Table -> Insert
C. Chqn Insert -> Table
D. Chgn Format -> Table

Ciu 95: D6 t4o mQt slide gi6ng hQt nhu slide hiQn hinh mi khdng phni thi6t t<6 t4i,
ngutri sfr dgng:

A. Chgn Insert ->Duplicate
B. Chqn Insert ->New Slide
C. Chqn Insert ->Duplicate Slide
D. Khdng thUc hiqn dugc

Ciu 96: E6 cin lii cho mQt do4n vin bin nho d6 trong giiro 6n iliQn tir tlang thi6t
k6, trufc tiOn ta phii:

:rv

ro rj
r si:
:,1KINI

iP IPI

rly,il

:
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B. La hinh thuc trao d6i thdng tin duoi d4ng thu thdng qua hQ th6ng m?ng m6y tinh.
C. ld c6c file dd dugc t4o ra bcyi word, excel, power point...r6i chuy6n sang dang
HTML.
^ -1. 

,
D. Tdt cd c6c cdu d6u sai.



A. Dua con tr6 vdn bin vdo gifia.
B. Chgn ci doan vdn bin cAn c5n ld.
C. Chgn mQt dong U6t ty trong do4n vdn bAn cAn can l€.
D. Ca 3 c6ch n6u trong cdu ndy d6u dring.

Ciu97z Cich thrfrc d6 m& I trang web sir dung Internet Explorer:
A. Nhap url crha trang web viro 6 Address r6i nhAn Enter.
B. Chqn File/ Open r6i nh4p url cua trang rveb rdi nhAn Enter.
C. Ca2 cdu tr6n d6u dring.
D. Ca 3 cdu tr6n ddu sai.

Cflu 98: Hyperlink lir gi?

A. Ld mQt thdnh phAn trong mQt trang Web li6n t6t atfn vi tri khric tr6n cung trang
Web d6 hoflc li6n k6t d6n mQt trang Web kh6c.
B. Ld nQi dung dugc th6 hign trOn web Browser (vrn b6n, f m thanh, hinh 6nh)
C. La dia chi cira 1 trang Web.
O.f6t ch c6c cdu tr€n dAu sai.

Ciu 99: Chgn ph6t bi6u tlfng vd ala chi IP:

A. Dia chi IP dung d6 x6c dinh tl6i tugng nh4n vd gtii thdn6, tin tr6n Internet.
B. Dia chi IP bao g6m 32 bit dugc chia thdnh 4 nh6m, m6i nh6m c6ch nhau bing d6u
chdm (.).
C. Cdu a vd b dAu dring.
D. Cdu a vd b ddu sai.

CAu 100: Chgn ph6t bi6u dring vd Email:

Ld phuong thric truydn tQp tin tu m6y ndy di5n m6y kh6c trOn mang.
Ld dfch vg cho ph6p ta truy c{p d6n h0 th6ng m6y tinh kh6c tr6n mAng.
Ld dich vg cho ph6p ta grii vi nhdn thu rli6n tt.
LA hinh thric hQi thopi tr.uc titlp tr6n Inrernet.

CAu 101: Chgn ph6t bi6u dring vd ten midn:

A. TCn mi6n ld t6n gqi nhd vd rnQt dia chi IP.
B. T6n miAn ld t6n -giao dich cria I c6ng ty hay t6 chric sri dung tr6n Internet .

C. Cdng viQc chuy6n dOi ttr t€n miAn sang dia chi IP do ma1 ch0 DNS dim tr6ch.
D. Tat ch cdc cdu tr6n d6u d[ng.

CAU 102: HTTP In gi?

A. La giao thtic truy,}n si6u vin bin.
B. La ng6n ngtr tl6 so4n th6o nQi dung c6c trang Web

A.
B.
C.
D.
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C. La t6n c[ra trang web.
D. Le dfa chi c[ra trang Web

Ciu 103: C6 th6 mO c6c file .html bing:

A. Trinh duyQt web (Browser) Internet Explorer.
B. Trinh duyQt web (Browser) Mozila.
C. C6c trinh duyQt mail nhu Outlook Express, Microsoft Outlook, ...
D. Cdu a vi b d6u dtng.

Ciu 104: D6 truy cfp viro mQt trang Web chring ta cin phni bi6t:

A. H9 di6u hdnh dang su dUng.
B. TOn midn cta trang Web.
C. Trang Web d6 cria nu6c ndo.
D. Tat cA dOu sai.

Cffu 105: TCP/IP dugc vi6t tit tt:
A. Transmission Control Protocol/ Internet Protocol.
B. Transmission Control Panel/ Internet Protocol.
C. Transaction Control Prototype/ Internet Prototype.
D. Transmission Control Protocol/ Internet Prototype

Ciu 106: E6 t4o mQt hQp thu iliQn tir moi:

A. Nguoi su dpng phai co sy cho phep cria co quan quin l1i dich vU lnternet.
B. Ngucri sft dpng ph6i c6 it nhdt mQt dia chi Website.
C. Nguoi st dpng kh6ng th6 tao cho minh mQt hdp thu m6i.
D. Nguoi srJr dqng co th6 <tang ky qua c6c nhd cung c6p dich vu Internet hoflc th6ng
qua c6c dia chi Website mi6n phi tr€n Internet tai b6t kj,il6u tr6n thtl gi6i.

Cflu 107: Dia chi thu iliQn tfr dugc ph6n cSch b&i ki hiQu:

Cflu 108: Trinh bhy cri phip ilia chi thu tliQn tir t6ng qurit:

A. < lop9b , @. yahoo.com >.

B. < TOn ddng cQp , @. T$n mdy cht luu hQp thu >.

C. < T6n ddng cpp , @. gmail.com >.

D. < TCn ddng cdp >.

't rf
/to

\.
i+

A.$
B.@
C,#
D.&
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CAu 109: Em suu tAm tlugc nhi6u inh ilgp mu6n gfri cho b4n bi O nhi6u noi em
dtng dich vg gi?

A. Thucrng mpi diQn tri.
B. Ddo t4o qua m?ng.
C. Thu ttiQn tt dinh kdm t6p.
D. Tim kii5m th6ng tin.

CAu 111: Trong c6c ciu sau tl6y, nhiing c6u nio lir sai khi n6i vdi tnei niQm dich
vU thu tliQn tfr?

A.Ldy lan virus gifra email nguoi giri vd email ngudi nh4n.
B. MOt nguoi c6 th6 grii email d6n nhitiu dia chi email kh6c nhau cung mQt hic.
C. MOt nguoi c6 thO grii email d6n dia chi email cria chinh rninh.
D. C6 th6 ddng ki hai dia chi email gi6ng nhau.

CAu 112: Vriri thu tlien tfr, ph6t bi6u nio sau tl6y lir sai?

A. Tep tin dinh kdm theo thu c6 th6 chria vinit, v4y n6n cAn kitlm tra virut trudc khi st
dung.
B. Hai ngudi c6 thi5 c6 dia chi thu gi6ng nhau, vi.dr,r hoahorLg@yahoo.com.
C. MQt nguoi c6 th€ gti thu cho chinh minh, nhi6u l6n.
D. C6 thd gti I thu d6n l0 ilia chi kh6c nhau.

CAu 113: MQt ngucri dang
chi nho dufi tl6y tlugc vi6t

sfr dgng dich vg thu iliQn tfr mi6n phi cria Google. Dia
tlfng?

A. gmail.com@yahoo2O 1 0
B. tracngh iem@y ahoo. com.vn
C. tracnghiem@gmail.com
D. B vd C d6u dring.

Ciu 114: Thu tliQn tfr ln dich vg chuy6n thu ducri d4ng:

A. S6.
B. Kf tg.
C. Media.
D. Audio.

l8

CAu 110: Thu iliQn tfr c6 uu tli6m gi so vni thu truy6n th5ng:

A. Thdi gian grii nhanh.
B. C6 th6 gti.d6ng thoi cho nhi6u nguoi.
C. Chi phi thdp.
D. Tat cd cdc uu di6m trdn.



Cffu 115: Sip x6p theo thri tg cic thao tric tI6 Oeng nhflp viro hQp thu iliQn tfr de
c6:

1. GO tOn ding nh$p vi m4t khiu.

2. Truy c$p vho trang Web cung cAp dich vg thu iliQn tfr.

3. M0Internet.

4. Nhrly chuQt vio nrit Ding nhap.

A. t-2-3-4.
8.3-2-r-4.
c" 4-3-2-1.
D.2-3-1-4.

Ciu 116: C6u trric 1 ilia chi email li:
A. <T6n_ngucri_dung > @<T An _mi dn>.
B. <T0n mi6n>@<T0n_ngudi_dung>.
C. <T0n_nguoi_dung>.<T0n_mi6n>.
D. <T0n_mi6n>.<Ten_nguol_dirng>.

Ciu 117: Trong c6c c6u sau cl6y, nh[rng cffu nio lir ihing khi mO te kh6i niQm thu
iliQn tfr?

A. Website c[ra dich vp thu diQn tft.
B. Trinh duyQt web.
C. La dich vq chuy6n thu dudi dpng sd tr0n m6y tinh.
D" La trang web.

Cffu 118: Trong cic ddng sau iliy, nhirng ddng nio lh tlia chi hQp thu iliQn tfr hgp
r0?

A. Nguyen trung anh @ gmail.com
B " nguyen anh@y ahoo. com
C. nguyen anh@ gmail.com
D. lop6a@gmail.com

CAu 119: Phit bi6u niro sau dffy v6 thu tliQn tft lir sai?

A. Hai nguoi c6 th6 co dfa chi thu gi6ng nhau, vi dq tracnghiem@gmail.com.
B. C6 thO grii 1 thu d6n nhi0u dfa chi kh6c nhau.
C. Mgt ngudi co th6 grii thu cho chinh minh, nhi6u lAn.

O.Tqp tin dinh kdm theo thu c6 th6 chtia virft, v4y n6n cin ki6m tra virut trudc khi sri
dung.

)
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CAu 120: Ngudi ki thu$t gin mQt thanh RAM 512 viro mQt miy tinh c6 card min
hinh onboard shared 64M8. Dung luqng RAM hiQn t4i mn HQ didu hinh sfr dqng
ln?

A. 256 MB
B. 448 MB
C. 512 MB
D. 576 MB

HET
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